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SUMMARY 15 
This protocol describes a mouse model of Salmonella driven intestinal fibrosis that resembles 16 
key pathological hallmarks of Crohn’s disease including transmural inflammation and fibrosis. 17 
This method can be used to evaluate host factors that alter fibrotic outcomes using mutant 18 
mice maintained on a C57Bl/6 genetic background. 19 
 20 
ABSTRACT 21 
Tissue fibrosis characterized by the pathological accumulation of extracellular matrix such as 22 
collagen is the outcome of persistent inflammation and dysregulated repair. In inflammatory 23 
bowel disease (IBD), fibrosis leads to recurrent stricture formations for which there is no 24 
effective therapy other than surgical resection. Due to its late onset, the processes that drive 25 
fibrosis is less studied and largely unknown. Therefore, fibrotic complications represent a 26 
major challenge in IBD. In this protocol, a robust in vivo model of intestinal fibrosis is 27 
described where streptomycin pre-treatment of C57Bl/6 mice followed by oral gavage with 28 
vaccine grade Salmonella Typhimurium ΔAroA mutant leads to persistent pathogen 29 
colonization and fibrosis of the cecum. Methodologies for preparing S. Typhimurium ΔAroA 30 
for inoculation, quantifying pathogen loads in the cecum and spleen, and evaluating collagen 31 
deposition in intestinal tissues are explained. This experimental disease model is useful for 32 
examining host factors that either enhance or exacerbate CD-like intestinal fibrosis. 33 
 34 
INTRODUCTION 35 
Ulcerative colitis (UC) and Crohn’s disease (CD) are the two major forms of IBD and are 36 
characterized as chronic and relapsing inflammatory disorders of the gastrointestinal tract 1,2. 37 
These disorders have a major impact on the quality of life of patients. Symptoms of IBD 38 
include abdominal pain, diarrhea, nausea, weight loss, fever, and fatigue3. Recent studies 39 
have identified genetic and environmental factors that contribute to disease pathogenesis; it 40 
is thought that such risk factors contribute to the disruption of the epithelial barrier resulting 41 
in the translocation or oversampling of luminal antigens4. As a consequence, this initiates an 42 
aberrant inflammatory response to the commensal flora mediated by intestinal immune 43 
cells4. Features of IBD-associated complications may extend to sites beyond the GI tract 44 
affecting various organs including joints, skin, and liver1,2. Hallmarks of UC include severe and 45 
diffuse inflammation typically localized in the colon1. Disease pathology affects the mucosa 46 
and submucosa of the bowel resulting in superficial mucosal ulcerations1. In contrast, CD can 47 

Manuscript Click here to access/download;Manuscript;60068_R3.docx

https://www.editorialmanager.com/jove/download.aspx?id=1041505&guid=91adf1d4-2a4c-4931-8170-c16b8a68d894&scheme=1
https://www.editorialmanager.com/jove/download.aspx?id=1041505&guid=91adf1d4-2a4c-4931-8170-c16b8a68d894&scheme=1


affect any part of the GI tract although evidence of disease is commonly found in the colon 48 
and distal ileum2. Moreover, the inflammation in CD is transmural, affecting all layers of the 49 
bowel wall2.  50 
 51 
Several IBD susceptibility genes that have been identified would indicate that dysregulation 52 
of the epithelial barrier or immunity are critical contributors to disease progression5. 53 
Mutations in nucleotide oligomerization domain 2 (NOD2) expressed by monocytes was 54 
found to be associated with increased susceptibility to CD; this highlights a link between 55 
altered innate immune detection of bacterial components and the disease6. More recent 56 
genome-wide association studies (GWAS) have revealed additional pathways potentially 57 
involved in the pathogenesis of IBD including genetic variations in: STAT1, NKX2-3, IL2RA, 58 
IL23R dependent pathways linked to adaptive immunity, MUC1, MUC19, and PTGER4 in 59 
intestinal barrier maintenance, and ATG16L-mediated autophagy7-9. While these population-60 
based genetics studies have enhanced our understanding of IBD, susceptibility alleles alone 61 
are likely insufficient in initiating and sustaining chronic disease3. Other non-genetic factors 62 
including alterations in gut microbiome composition and a reduction in diversity have been 63 
associated with intestinal inflammation. However, it is unclear whether gut dysbiosis 64 
precedes or is the consequence of dysregulated immune responses3.  Although the etiology 65 
of IBD remains unclear, our understanding of the pathogenesis of the disease has been 66 
enhanced by experimental mouse models of intestinal inflammation10,11. These models 67 
individually do not fully represent the complexity of the human disease, but they are valuable 68 
for elucidating pathophysiological pathways that could be relevant to IBD and for the 69 
validation of tentative therapeutic strategies10,11. Such mouse models typically rely on the 70 
initiation of inflammation by chemical induction or infection, immune cell transfer, or genetic 71 
manipulation. Moreover, these strategies often involve perturbations in epithelial integrity or 72 
modulation of innate or adaptive immunity.  73 
 74 
Salmonella enterica serovars are intestinal pathogens that can infect humans and mice. After 75 
ingestion, Salmonella can colonize the gut by direct invasion of epithelia, M cells, or antigen 76 
presenting cells12. Mice infected orally with S. Typhimurium results in the colonization 77 
primarily of systemic sites such as the spleen and mesenteric lymph nodes with relatively low 78 
abundance in the GI tract12. However, pretreatment of mice with streptomycin enhances the 79 
efficiency of Salmonella colonization of the gut by diminishing the host protective effects of 80 
the normal microbiota13. Pathological features of this model include the disruption or 81 
ulceration of the epithelial barrier, granulocyte recruitment, and severe edema13. 82 
Alternatively, infection with the vaccine grade S. Typhimurium ΔAroA mutant leads to chronic 83 
colonization of the cecum and colon that persists up to day 40 after infection14. The S. 84 
Typhimurium ΔAroA strain has a defect in the biosynthesis of aromatic amino acids; this 85 
renders the mutant strain avirulent and can be utilized as a highly effective vaccine15. Oral 86 
infection in mice leads to a Th1- and Th17-cytokine associated inflammatory response, 87 
extensive tissue remodeling, and collagen deposition. Tissue pathology is associated with 88 
elevated levels of pro-fibrotic factor such as TGF-β1, CTGF, and IGF14. The transmural fibrotic 89 
scarring reported in this model is reminiscent of stricture formations often observed in IBD. 90 
The induction of fibrosis by Salmonella requires virulence encoded by Salmonella 91 
pathogenicity islands (SPI)-1 and 2 12. Importantly, this S. Tymphimurium ΔAroA infection 92 
model is a useful system for the study of fibrotic responses in mutant mice maintained on a 93 
C57/Bl6 background. The C57/Bl6 strain is extremely sensitive to S. Typhiumurim SL1344 94 



infection due to a loss-of-function mutation in the gene encoding the natural resistance-95 
associated macrophage protein (NRAMP)-116,17. We have found that IL-17A and RORα-96 
dependent innate lymphoid cells are important contributors to pathogenesis in this model18. 97 
 98 
A major complication of CD is the dysregulated and excessive deposition of extracellular 99 
matrix (ECM) including collagen2,19. Although the GI tract has a relatively high capacity for 100 
regeneration, fibrotic scarring can arise due to unresolved wound healing responses that are 101 
associated with chronic and severe inflammation20,21. In CD, this results in deleterious effects 102 
on tissue architecture leading to significant organ impairment21,22. The transmural nature of 103 
the inflammation observed in CD ultimately precedes the thickening of the bowel wall 104 
associated with symptomatic stenosis or stricture formation21. About a third of CD patients 105 
require intestinal resection for this complication22. There are no effective anti-fibrotic 106 
therapies in IBD given that the use of immunosuppressants such as azathioprine or anti-TNFα 107 
biologics have no impact or only modestly reduced the requirement of surgical 108 
interventions19,23. While fibrosis is thought be the consequence of chronic inflammation, cells 109 
of mesenchymal origin such as fibroblasts and pericytes are thought to be the primary cellular 110 
sources of ECM in fibrotic scarring21,24. Chronic S. Typhimurium ΔAroA infection is a robust 111 
mouse model of intestinal fibrosis that can offer insights into the pathogenesis of CD-like 112 
features. 113 
 114 
PROTOCOL 115 
All animal protocols were approved by the Animal Care Committee of the University of British 116 
Columbia.  117 
 118 
1. Preparation of Salmonella Typhimurium ΔAroA cultures for oral gavage of mice 119 
 120 
1.1. From a frozen glycerol stock of S. Typhimurium ΔAroA, prepare a streak plate using LB 121 
agar containing 100 μg/mL streptomycin with a sterile inoculating loop. Incubate overnight at 122 
37 ˚C. Streak plates can be stored up to one week at 4 ˚C. 123 
 124 
1.2. One day prior to infection, prepare antibiotic by dissolving 0.5 g of streptomycin in 2.5 125 
mL of water. After filter sterilizing streptomycin solution, orally gavage the mice using a bulb-126 
tipped 22G gavage needle and 1 mL syringe with 100 μL of streptomycin solution (20 mg 127 
streptomycin/dose). Using an inoculating loop, inoculate 3 mL of LB broth (50 μg/mL 128 
streptomycin) in a culture tube with a single colony. Incubate Salmonella culture aerobically 129 
at 37 ˚C overnight with shaking at 200 RPM. 130 
 131 
1.3. On day of infection, prepare final infection dose by performing 2 consecutive 1/10 132 
dilutions of overnight Salmonella cultures in sterile PBS. This would result in a 100 μL inoculum 133 
containing approximately 3 x 106 CFU. 134 
 135 
1.4. Using a bulb-tipped 22G gavage needle and a 1 mL syringe, gavage each mouse with 136 
100 μL of the prepared Salmonella. 137 
 138 
NOTE: Prepare Salmonella cultures using aseptic techniques. Final inoculation concentration 139 
of Salmonella may be verified by plating serial dilutions on LB agar with streptomycin. The S. 140 



Typhimurium ΔAroA strain can be obtained by contacting Professor McNagny 141 
(kelly@brc.ubc.ca). 142 
 143 
2. Assessment of Salmonella burdens in tissues 144 
 145 
2.1. Prepare 2 mL safe-lock, round bottom microtubes with 1 mL of sterile PBS and an 146 
autoclaved stainless steel bead. Pre-weigh the tubes prior to tissue collection. 147 
 148 
2.2. Resect cecal and splenic tissues from mice euthanized by carbon dioxide exposure.  149 
Collect tissue from individual animals in separate tubes. Weigh the tubes to determine tissue 150 
weights. 151 
 152 
2.3. Homogenize using a mixer mill apparatus for 15 min at 30 Hz. Transfer 900 μL of PBS 153 
per well in a 96-well 2-mL megablock. Pipette 100 μL of tissue homogenates into the first well, 154 
mix well, and perform serial dilutions by adding 100 μL to subsequent wells until a 10-6 dilution 155 
is obtained. Plate 10 μL of each dilution in triplicates onto LB agar containing 100 μg/mL 156 
streptomcyin. 157 
 158 
2.4. Count and multiply average CFU by a factor of 100 since 10 μL of the 1000 μL sample 159 
was plated, and the appropriate dilution factor. Divide tissue weight total CFU by tissue 160 
weights to determine CFU per gram of tissue. 161 
 162 
NOTE: Keep all samples on ice or at 4 ˚C during tissue processing. Use wide-orifice pipette tips 163 
when performing serial dilutions with tissue homogenates. Prepare the 96-well megablock 164 
containing PBS in advance. 165 
 166 
3. Picrosirius Red staining and quantification of collagen. 167 
 168 
3.1. Fix cecal tissues overnight in 10% buffered formalin and prepare for paraffin 169 
embedding. Cut 5-μm sections for Picrosirius Red staining as described previously25. 170 
 171 
3.2. Capture composite images of whole cecal cross-sections on a brightfield microscope. 172 
 173 
3.3. Open Fiji (ImageJ) and drag and drop the .tif image file onto the toolbar. 174 
 175 
3.4. On the menu bar, select Image > Type > RGB Stack to split the image into red, green, 176 
and blue channels. Slide the horizontal bar at the bottom of the panel to set the channel to 177 
Green.  178 
 179 
3.5. Open Image > Adjust > Threshold tool. Adjust minimum and maximum limits to 180 
eliminate any background signals. Once the desired threshold is set, close the threshold tool 181 
and go to Analyze > Set Measurements. Check off Area, Area Fraction, Limit to threshold, 182 
and Display label.  183 
 184 
3.6. Gate the tissue section with either Freehand selections or Polygon selections tool 185 
and measure the % area positive for collagen by clicking Analyze > Measure.  186 
 187 



3.7. Normalize the absolute area positive for collagen staining to tissue area. 188 
 189 
NOTE: Fiji (ImageJ) is an open-source program that can be downloaded at https://fiji.sc. 190 
Images with same capture conditions (i.e., brightness and focus) must have identical 191 
threshold limits for accurate quantification. If there is any background staining within the 192 
selected tissue, measure the absolute area and subtract it from the area positive for collagen 193 
from the entire tissue. 194 
 195 
REPRESENTATIVE RESULTS 196 
Streptomycin treatment followed by oral infection with S. Typhimurium ΔAroA leads to robust 197 
intestinal inflammation and fibrosis especially in the cecum (Figure 1). Typical pathogen 198 
burdens of 108 to 109 CFU per 1 g of cecum and 104 CFU per 1 g of spleen can be recovered 199 
from infected animals (Figure 2). Assessment of fibrosis in picrosirius red stained cecal 200 
sections indicate peak fibrosis 21 days after infection while much of the pathology is resolved 201 
by day 42 pi (Figure 3-4). Collagen deposition is most pronounced in the submucosa of the 202 
intestine while fibrosis in the mucosa is milder. 203 
 204 
FIGURE AND TABLE LEGENDS 205 
Figure 1. Diagram of cecal sectioning for histology, Salmonella burden assessment, and 206 
cytokine quantification. Segment 1 representing the cecal tip may be used for gene 207 
expression analysis while segment 2 will be fixed in 10% buffered formalin for histology and 208 
Segment 3 will be homogenized for bacterial enumeration. 209 
 210 
Figure 2. Pathogen burdens in ceca and spleens. Salmonella CFU per weight of tissue during 211 
course of infection. This figure has been modified from Lo et al.26. 212 
 213 
Figure 3. Picrosirius red stained cross sections of intestinal tissue. Bright field images of ceca 214 
from uninfected animals and animals 21 and 42 days after S. Typhimurium ΔAroA infection. 215 
Scale bar, 200 μm. This figure has been modified from Lo et al.26. 216 
 217 
Figure 4. Quantification of collagen deposition by morphometric analyses. (A) PSR+ staining 218 
normalized to tissue area. Significance determined by one-way ANOVA Kruskal-Wallis test 219 
with Dunns post test. **, P < 0.01, N.S., P > 0.05. This figure has been modified from Lo et 220 
al.26. (B) Example of collagen quantification in cecal tissue using Fiji.  221 
 222 
DISCUSSION 223 
Our understanding of the pathogenesis of IBD has been greatly enhanced by mouse models 224 
of intestinal inflammation. Although such individual models do not recapitulate all features 225 
of the complex and multifactorial human disease, they have been useful in identifying key 226 
features of disease progression. Fibrotic strictures associated with IBD remains a major unmet 227 
clinical need as current treatments are ineffective in reversing disease development. 228 
Moreover, intestinal fibrosis is difficult to study in a laboratory setting due to limitations in 229 
current animal models. Chronic exposure to TNBS in BALB/c mice has been shown to induce 230 
robust collagen deposition in the colon that is driven by IL-13 and TGF-B1 signaling27,28. 231 
However, intestinal fibrosis is not commonly observed in other routinely used laboratory 232 
models of colitis such as DSS treatment, IL-10-deficient, or adoptive T cell transfer models. 233 
Grassl et al. demonstrated that chronic gastrointestinal infection of C57Bl6 with the 234 
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attenuated ΔAroA mutant Salmonella strain results in robust fibrosis in the mucosal and 235 
submucosal regions of the cecum12. They reported that peak fibrosis occurred three weeks 236 
after infection and was associated with Th1 and Th17 immunity and elevated pro-fibrotic 237 
factors TGF-B1, CTGF, and IGF-112. This pathology is reminiscent of CD as the severe 238 
inflammation and fibrosis is transmural. While IBD is typically progressive, one important 239 
limitation of the chronic Salmonella infection model is the transient nature of the fibrotic 240 
immunopathology. In C57Bl/6 mice, intestinal disease is typically resolved by week six after 241 
infection. Despite this shortcoming, the latter stages of this infection model can be utilized to 242 
identify factors or processes involved in promoting disease remission26.  243 
 244 
Although bacterial pathogen-driven models of colitis are well studied, there is no association 245 
between Salmonella and CD. However, it has been proposed that the magnitude of fibrotic 246 
disease during the latter stages of chronic Salmonella colonization does not directly correlate 247 
with pathogen burdens suggesting that the pathology is “self-propagating” once severe 248 
intestinal inflammation is initiated by Salmonella29. In contrast, the adherent-invasive 249 
Escherichia coli (AIEC) pathovar has been strongly linked to the development of CD because 250 
of its high prevalence in the ileal mucosa of patients30. In addition, persistent AIEC 251 
colonization (up to 9 weeks) of the ileum, cecum and colon of several mouse strains including 252 
C57Bl/6 leads to robust matrix accumulation in the gut via flagellin expression thus 253 
demonstrating the fibrogenic induction potential of this pathobiont31,32. The recent 254 
development of infection driven models of intestinal fibrosis have provided robust 255 
experimental models of IBD. These have provided new systems to dissect the relationship 256 
between enteric bacterial species including their virulence factors, and host susceptibility 257 
factors that may enhance our understanding of IBD-associated fibrosis. 258 
 259 
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Name of Material/ Equipment
Compan

y
Catalog Number Comments/Description

2 ml round bottom safe lock tubes

Eppendor

f 22363344

Stainless steel beads Qiagen 69989

PBS Gibco 10010031

Large-Orifice Pipet Tips Fisher 2707134

2 mL megablock plates Sarstedt 82.1972.002

Gavage needles FST 18061-22

Streptomycin sulfate Sigma S9137

Mixer mill Retsch MM
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Title of Article:  

 

Author(s):  

 

 

Item 1: The Author elects to have the Materials be made available (as described at 

http://www.jove.com/publish) via: 

� Standard Access  � Open Access

 

Item 2: Please select one of the following items: 

� The Author is NOT a United States government employee. 

� The Author is a United States government employee and the Materials were prepared in the 

course of his or her duties as a United States government employee. 

� The Author is a United States government employee but the Materials were NOT prepared in the 

course of his or her duties as a United States government employee. 

 

ARTICLE AND VIDEO LICENSE AGREEMENT 
 

1. Defined Terms. As used in this Article and Video 

License Agreement, the following terms shall have the 

following meanings: “Agreement” means this Article and 

Video License Agreement; “Article” means the article 

specified on the last page of this Agreement, including any 

associated materials such as texts, figures, tables, artwork, 

abstracts, or summaries contained therein; “Author” 

means the author who is a signatory to this Agreement; 

“Collective Work” means a work, such as a periodical issue, 

anthology or encyclopedia, in which the Materials in their 

entirety in unmodified form, along with a number of other 

contributions, constituting separate and independent 

works in themselves, are assembled into a collective whole; 

“CRC License” means the Creative Commons Attribution-

Non Commercial-No Derivs 3.0 Unported Agreement, the 

terms and conditions of which can be found at: 

http://creativecommons.org/licenses/by-nc-

nd/3.0/legalcode; “Derivative Work” means a work based 

upon the Materials or upon the Materials and other pre-

existing works, such as a translation, musical arrangement, 

dramatization, fictionalization, motion picture version, 

sound recording, art reproduction, abridgment, 

condensation, or any other form in which the Materials may 

be recast, transformed, or adapted; “Institution” means 

the institution, listed on the last page of this Agreement, by 

which the Author was employed at the time of the creation 

of the Materials; “JoVE” means MyJove Corporation, a 

Massachusetts corporation and the publisher of The Journal 

of Visualized Experiments; “Materials” means the Article 

and / or the Video; “Parties” means the Author and JoVE; 

“Video” means any video(s) made by the Author, alone or 

in conjunction with any other parties, or by JoVE or its 

affiliates or agents, individually or in collaboration with the 

Author or any other parties, incorporating all or any portion 

of the Article, and in which the Author may or may not 

appear. 

2. Background. The Author, who is the author of the 

Article, in order to ensure the dissemination and protection 

of the Article, desires to have the JoVE publish the Article 

and create and transmit videos based on the Article. In 

furtherance of such goals, the Parties desire to memorialize 

in this Agreement the respective rights of each Party in and 

to the Article and the Video. 

3. Grant of Rights in Article. In consideration of JoVE 

agreeing to publish the Article, the Author hereby grants to 

JoVE, subject to Sections 4 and 7 below, the exclusive, 

royalty-free, perpetual (for the full term of copyright in the 

Article, including any extensions thereto) license (a) to 

publish, reproduce, distribute, display and store the Article 

in all forms, formats and media whether now known or 

hereafter developed (including without limitation in print, 

digital and electronic form) throughout the world, (b) to 

translate the Article into other languages, create 

adaptations, summaries or extracts of the Article or other 

Derivative Works (including, without limitation, the Video) 

or Collective Works based on all or any portion of the Article 

and exercise all of the rights set forth in (a) above in such 

translations, adaptations, summaries, extracts, Derivative 

Works or Collective Works and(c) to license others to do any 

or all of the above. The foregoing rights may be exercised in 

all media and formats, whether now known or hereafter 

devised, and include the right to make such modifications 

as are technically necessary to exercise the rights in other 

media and formats. If the “Open Access” box has been 

checked in Item 1 above, JoVE and the Author hereby grant 

to the public all such rights in the Article as provided in, but 

subject to all limitations and requirements set forth in, the 

CRC License. 

 

 

Chronic Salmonella infection induces intestinal fibrosis

Bernard C. Lo, Samuel B. Shin, Melina Messing, Kelly M. McNagny
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4. Retention of Rights in Article. Notwithstanding 

the exclusive license granted to JoVE in Section 3 above, the 

Author shall, with respect to the Article, retain the non-

exclusive right to use all or part of the Article for the non-

commercial purpose of giving lectures, presentations or 

teaching classes, and to post a copy of the Article on the 

Institution’s website or the Author’s personal website, in 

each case provided that a link to the Article on the JoVE 

website is provided and notice of JoVE’s copyright in the 

Article is included. All non-copyright intellectual property 

rights in and to the Article, such as patent rights, shall 

remain with the Author. 

5. Grant of Rights in Video – Standard Access. This 

Section 5 applies if the “Standard Access” box has been 

checked in Item 1 above or if no box has been checked in 

Item 1 above. In consideration of JoVE agreeing to produce, 

display or otherwise assist with the Video, the Author 

hereby acknowledges and agrees that, Subject to Section 7 

below, JoVE is and shall be the sole and exclusive owner of 

all rights of any nature, including, without limitation, all 

copyrights, in and to the Video. To the extent that, by law, 

the Author is deemed, now or at any time in the future, to 

have any rights of any nature in or to the Video, the Author 

hereby disclaims all such rights and transfers all such rights 

to JoVE. 

6. Grant of Rights in Video – Open Access. This 

Section 6 applies only if the “Open Access” box has been 

checked in Item 1 above. In consideration of JoVE agreeing 

to produce, display or otherwise assist with the Video, the 

Author hereby grants to JoVE, subject to Section 7 below, 

the exclusive, royalty-free, perpetual (for the full term of 

copyright in the Article, including any extensions thereto) 

license (a) to publish, reproduce, distribute, display and 

store the Video in all forms, formats and media whether 

now known or hereafter developed (including without 

limitation in print, digital and electronic form) throughout 

the world, (b) to translate the Video into other languages, 

create adaptations, summaries or extracts of the Video or 

other Derivative Works or Collective Works based on all or 

any portion of the Video and exercise all of the rights set 

forth in (a) above in such translations, adaptations, 

summaries, extracts, Derivative Works or Collective Works 

and (c) to license others to do any or all of the above. The 

foregoing rights may be exercised in all media and formats, 

whether now known or hereafter devised, and include the 

right to make such modifications as are technically 

necessary to exercise the rights in other media and formats. 

For any Video to which this Section 6 is applicable, JoVE and 

the Author hereby grant to the public all such rights in the 

Video as provided in, but subject to all limitations and 

requirements set forth in, the CRC License. 

7. Government Employees. If the Author is a United 

States government employee and the Article was prepared 

in the course of his or her duties as a United States 

government employee, as indicated in Item 2 above, and 

any of the licenses or grants granted by the Author 

hereunder exceed the scope of the 17 U.S.C. 403, then the 

rights granted hereunder shall be limited to the maximum 

rights permitted under such statute. In such case, all 

provisions contained herein that are not in conflict with 

such statute shall remain in full force and effect, and all 

provisions contained herein that do so conflict shall be 

deemed to be amended so as to provide to JoVE the 

maximum rights permissible within such statute. 

8. Protection of the Work. The Author(s) authorize 

JoVE to take steps in the Author(s) name and on their behalf 

if JoVE believes some third party could be infringing or 

might infringe the copyright of either the Author’s Article 

and/or Video. 

9. Likeness, Privacy, Personality. The Author hereby 

grants JoVE the right to use the Author’s name, voice, 

likeness, picture, photograph, image, biography and 

performance in any way, commercial or otherwise, in 

connection with the Materials and the sale, promotion and 

distribution thereof. The Author hereby waives any and all 

rights he or she may have, relating to his or her appearance 

in the Video or otherwise relating to the Materials, under 

all applicable privacy, likeness, personality or similar laws. 

10. Author Warranties. The Author represents and 

warrants that the Article is original, that it has not been 

published, that the copyright interest is owned by the 

Author (or, if more than one author is listed at the beginning 

of this Agreement, by such authors collectively) and has not 

been assigned, licensed, or otherwise transferred to any 

other party. The Author represents and warrants that the 

author(s) listed at the top of this Agreement are the only 

authors of the Materials. If more than one author is listed 

at the top of this Agreement and if any such author has not 

entered into a separate Article and Video License 

Agreement with JoVE relating to the Materials, the Author 

represents and warrants that the Author has been 

authorized by each of the other such authors to execute this 

Agreement on his or her behalf and to bind him or her with 

respect to the terms of this Agreement as if each of them 

had been a party hereto as an Author. The Author warrants 

that the use, reproduction, distribution, public or private 

performance or display, and/or modification of all or any 

portion of the Materials does not and will not violate, 

infringe and/or misappropriate the patent, trademark, 

intellectual property or other rights of any third party. The 

Author represents and warrants that it has and will 

continue to comply with all government, institutional and 

other regulations, including, without limitation all 

institutional, laboratory, hospital, ethical, human and 

animal treatment, privacy, and all other rules, regulations, 

laws, procedures or guidelines, applicable to the Materials, 

and that all research involving human and animal subjects 

has been approved by the Author's relevant institutional 

review board. 

11. JoVE Discretion. If the Author requests the 

assistance of JoVE in producing the Video in the Author’s 

facility, the Author shall ensure that the presence of JoVE 

employees, agents or independent contractors is in 

accordance with the relevant regulations of the Author's 

institution. If more than one author is listed at the 

beginning of this Agreement, JoVE may, in its sole 
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discretion, elect not take any action with respect to the 

Article until such time as it has received complete, executed 

Article and Video License Agreements from each such 

author. JoVE reserves the right, in its absolute and sole 

discretion and without giving any reason therefore, to 

accept or decline any work submitted to JoVE. JoVE and its 

employees, agents and independent contractors shall have 

full, unfettered access to the facilities of the Author or of 

the Author’s institution as necessary to make the Video, 

whether actually published or not. JoVE has sole discretion 

as to the method of making and publishing the Materials, 

including, without limitation, to all decisions regarding 

editing, lighting, filming, timing of publication, if any, 

length, quality, content and the like.  

12. Indemnification. The Author agrees to indemnify 

JoVE and/or its successors and assigns from and against any 

and all claims, costs, and expenses, including attorney’s 

fees, arising out of any breach of any warranty or other 

representations contained herein. The Author further 

agrees to indemnify and hold harmless JoVE from and 

against any and all claims, costs, and expenses, including 

attorney’s fees, resulting from the breach by the Author of 

any representation or warranty contained herein or from 

allegations or instances of violation of intellectual property 

rights, damage to the Author’s or the Author’s institution’s 

facilities, fraud, libel, defamation, research, equipment, 

experiments, property damage, personal injury, violations 

of institutional, laboratory, hospital, ethical, human and 

animal treatment, privacy or other rules, regulations, laws, 

procedures or guidelines, liabilities and other losses or 

damages related in any way to the submission of work to 

JoVE, making of videos by JoVE, or publication in JoVE or 

elsewhere by JoVE. The Author shall be responsible for, and 

shall hold JoVE harmless from, damages caused by lack of 

sterilization, lack of cleanliness or by contamination due to 

the making of a video by JoVE its employees, agents or 

independent contractors. All sterilization, cleanliness or 

decontamination procedures shall be solely the 

responsibility of the Author and shall be undertaken at the 

Author’s expense. All indemnifications provided herein 

shall include JoVE’s attorney’s fees and costs related to said 

losses or damages. Such indemnification and holding 

harmless shall include such losses or damages incurred by, 

or in connection with, acts or omissions of JoVE, its 

employees, agents or independent contractors. 

13. Fees. To cover the cost incurred for publication, 

JoVE must receive payment before production and 

publication the Materials. Payment is due in 21 days of 

invoice. Should the Materials not be published due to an 

editorial or production decision, these funds will be 

returned to the Author. Withdrawal by the Author of any 

submitted Materials after final peer review approval will 

result in a US$1,200 fee to cover pre-production expenses 

incurred by JoVE. If payment is not received by the 

completion of filming, production and publication of the 

Materials will be suspended until payment is received. 

14. Transfer, Governing Law. This Agreement may be 

assigned by JoVE and shall inure to the benefits of any of 

JoVE’s successors and assignees. This Agreement shall be 

governed and construed by the internal laws of the 

Commonwealth of Massachusetts without giving effect to 

any conflict of law provision thereunder. This Agreement 

may be executed in counterparts, each of which shall be 

deemed an original, but all of which together shall be 

deemed to me one and the same agreement. A signed copy 

of this Agreement delivered by facsimile, e-mail or other 

means of electronic transmission shall be deemed to have 

the same legal effect as delivery of an original signed copy 

of this Agreement.

 

A signed copy of this document must be sent with all new submissions. Only one Agreement is required per submission. 

 

CORRESPONDING AUTHOR 
Name:    

 

Department:   

 

Institution:  

 

Title:   

 

Signature:  

 

Date:  

Please submit a signed and dated copy of this license by one of the following three methods: 

1. Upload an electronic version on the JoVE submission site 

2. Fax the document to +1.866.381.2236 

3. Mail the document to JoVE / Attn: JoVE Editorial / 1 Alewife Center #200 / Cambridge, MA 02140 

 

 

 

 

 

 

 

 

Kelly M. McNagny

Medical Genetics

University of British Columbia

Professor

Kelly McNagny March 30, 2019



1. Please do not abbreviate journal titles for references. 
 
This has now been corrected. 
 
2. In Representative Results section, the paragraph text should refer to all of the 
figures. 
  
This has now been corrected. 
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